# Table of Contents

1. **Introduction** .......................................................... 5
   1.1 System Features .................................................... 5
   1.2 AxTrax Server and Client ........................................... 6
   1.3 Using this User Guide .............................................. 6

2. **Specifications and Requirements** ................................. 7
   2.1 System Capabilities ................................................ 7
   2.2 System Requirements .............................................. 8

3. **Installation** ........................................................... 9
   3.1 Choosing an SQL Server ........................................... 9
   3.2 Starting the AxTrax Installer ..................................... 9
   3.3 Installing AxTrax AS-525 ......................................... 10
   3.4 Firewall Settings .................................................. 15
   3.5 Camera Installation & Requirement Steps .................. 15

4. **System Overview** .................................................. 17
   4.1 Starting the Software .............................................. 17
   4.2 The AxTrax AS-525 Main Window .............................. 18
   4.3 Menu Bar ............................................................ 19
   4.4 Toolbar ............................................................... 20
   4.5 Tree View ............................................................ 22

5. **How to Set Up a Site** ............................................. 25
   5.1 Defining Time Zones .............................................. 26
   5.2 Defining a Network ............................................... 27
   5.3 Adding Access Control Panels ................................. 29
   5.4 Setting Door Properties .......................................... 35
   5.5 Configuring the Reader .......................................... 36
   5.6 Configuring the Inputs .......................................... 40
# Table of Contents

5.7 Creating Access Groups........................................................... 41
5.8 Defining Cards......................................................................... 43
5.9 Enrolling cards using MD-08................................................... 44
5.10 Defining Departments and Users .............................................45
5.11 Creating Access Areas and Global Antipassback Rules ...........51
5.12 Setting Panel Links ..................................................................53
5.13 Creating Status Maps.................................................................55

6. **Vitrax Video Integration** ......................................................58
   6.1 Connecting to ViTrax Server ...................................................58
   6.2 Adding a Camera to AC-525 panel.......................................... 60
   6.3 Conditioned Recording via Panel Links ..................................61
   6.4 Viewing Recorded events ........................................................62

7. **Manual Operation** ................................................................65
   7.1 Controlling the Door Manually................................................ 65
   7.2 Changing the Reader Mode...................................................... 66
   7.3 Controlling Outputs Manually .................................................67
   7.4 Manually Disarming Inputs .....................................................68
   7.5 Testing the Siren ......................................................................69

8. **Reports** ............................................................................... 71
   8.1 Immediate Reports................................................................... 71
   8.2 Archive Reports .......................................................................72

9. **Administrator Operations** .....................................................73
   9.1 Setting the Time and Date........................................................ 73
   9.2 Detecting Panels Automatically..............................................73
   9.3 Manual Download of Panel Data ............................................. 74
   9.4 Downloading Failed Data ........................................................75
   9.5 Testing User Counters...............................................................76
   9.6 Maintaining the Database ........................................................77
   9.7 AxTrax Options and Preferences .............................................79
## Table of Contents

9.8 Importing User Data ................................................................. 83

Appendix A. Firewall Configuration................................. 85

Appendix B. Network Configuration ................................. 90

Appendix C. Technical Support ........................................... 97
1. **Introduction**

The AxTrax AS-525 Access Control System® is a complete software management system for use with AC-215, AC-225 and AC-525 Access control panels.

The AxTrax AS-525 Access Control System® is user-friendly, intuitive, and rich in functionality. The system can manage up to 30,000 users and offers complete control over up to 4092 doors (with MD-D02 reader expansion board). Using AxTrax AS-525, configured doors by area and time, for different types of personnel and for varying alarm situations.

The AxTrax AS-525 Access Control System® is capable of integrating with Video Surveillance software “Vitrax”. The main purpose of the integration is to enable video recording based on access control events and convenient playback.

1.1 **System Features**

The AxTrax AS-525 makes it possible to control and monitor every aspect of access control on a site. The system includes an in-built software security system that controls access to the system database and logs all operations performed. In addition, the system boasts the following Professional Grade Features:

- **Free basic level-0 server software license for up to 64 panels (ACU’s).** Three incremental license levels can be activated by buying a Rosslare HASP key (CD-ROM is provided with the package)
- **User-friendly PC software with intuitive layout reduces complexity of access control**
- **Manages user data, photo and information fields, access rights, alarms, strike time, and door mode, all from one central location**
- **Produces reports from acquired data, such as entry and exit times, and any types of alarms, by user, location, and time**
- **Available in a large variety of languages**
- **Compatible with additional software modules from Rosslare for time and attendance and photo ID card development**
- **Backward compatibility with VeriTrax AS-215 and AS-225**

**Access Control**

Access groups define access rights for every part of the site. Access rights are time dependent— for example, users in the "Mornings Only" access group could have access to certain areas of the site between 9am and 12pm only.

Every user is assigned to an access group. The system also stores an identification photograph and personal details for each user and user specific access settings, such as antipassback immunity; requirements for
an extended open door period; configurable special privileges and triggered outputs.

**Access Monitoring**

The AxTrax AS-525 records every attempt to open a door within the site. Status maps show the state of every part of a facility, while an Events log records complete details of every time access granted or denied for every door on site while also monitoring possible door tampering and forced entries.

The AxTrax AS-525 can also produce a variety of access reports, including usage reports, attendance records and roll calls. Using the AxTrax Report Wizard, users can design their custom reports to meet their specific needs.

**Software Security**

Access to the AxTrax AS-525 software is password controlled. It is possible to grant different operators restricted security rights, with access to only specified elements of the system or with read-only access.

### 1.2 AxTrax Server and Client

The AxTrax AS-525 system includes both the AxTrax AS-525 Server and the AxTrax AS-525 Client software.

**AxTrax AS-525 Server** should be installed on the computer that will control the Access control panels and manage the database. It includes a full suite of administrator functions, including the ability to change panel network parameters, download new firmware to individual access control panels and manage the AxTrax AS-525 database.

Additional computers can use the AxTrax AS-525 Client software, which connects to the panel network through the AxTrax AS-525 Server. The AxTrax Client has a limited operation set, and can only send or receive information from Access Control panels when the AxTrax Server is operating and connected to the panel network.

One AxTrax AS-525 Server can serve an unlimited number of AxTrax AS-525 Clients.

### 1.3 Using this User Guide

This user guide provides all the information required to start working with the AxTrax AS-525, refer to the AC-215, AC-225 or the AC-525 hardware manuals for wiring and installation.

- How to install the AxTrax AS-525 on a computer
- The basic functionality of the AxTrax AS-525
- How to set-up the AxTrax AS-525 for a new site
- How to monitor and manage a site using the AxTrax AS-525
2. Specifications and Requirements

2.1 System Capabilities

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Software Architecture</strong></td>
</tr>
<tr>
<td><strong>Database type</strong></td>
</tr>
<tr>
<td><strong>Max. of Users</strong></td>
</tr>
<tr>
<td><strong>Max. Access Groups</strong></td>
</tr>
<tr>
<td><strong>Max. Number of Time zones</strong></td>
</tr>
<tr>
<td><strong>Max. Cards per User</strong></td>
</tr>
<tr>
<td><strong>Max. Number of Doors</strong></td>
</tr>
<tr>
<td><strong>Max. Access Control Panels</strong></td>
</tr>
<tr>
<td><strong>Antipassback</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>International Holiday Support?</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max. Number of Networks</strong></td>
</tr>
<tr>
<td><strong>Supported Access Control Panel Models</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Panel Networks communication interface</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
### Specifications and Requirements

| Communication speed | 9600–115200 bps |

#### 2.2 System Requirements

**AxTrax AS-525 System Requirements**

| Operating System | Windows XP SP2, Windows Vista |
| Processor         | Pentium 4 or better          |
| Memory            | 256 MB (512 MB recommended)  |
| Network           | LAN card required for TCP/IP networking |
| Hard Disk space   | 1.5 GB (500 MB free space)   |

**SQL Express Server Requirements**

(SQL Server Express is not always required. See Choosing an SQL Server, page 9.)

| Operating System | Windows XP SP2, Windows Server 2003, Windows Vista |
| Processor        | Pentium 4 or better |
| Memory           | 256 MB (512 MB recommended) |
| Hard Disk space  | 600 MB (256 MB free space) |

**HASP USB Key Requirements**

| 1-64 active panels | HASP key not required |
| 65-256 active panels | Level 1 HASP key required |
| 257-512 active panels | Level 2 HASP key required |
| 513-1023 active panels | Level 3 HASP key required |
3. **Installation**

The AxTrax AS-525 installation CD-ROM includes all the set-up files required to run the AxTrax Server or Client on a computer. The installer includes the following elements:

- Microsoft™ SQL Server 2005 Express
- Microsoft™ .NET 2.0 Framework
- AxTrax AS-525 Access Control System (Server or Client version)
- HASP key controller (AxTrax Server only)

**Note:**

SQL Server Express and the Microsoft .NET Framework are prerequisite software and are not installed unless required.

3.1 **Choosing an SQL Server**

The AxTrax Server operates using an SQL database. If there is already an SQL server available on your computer network, use it to run the AxTrax database. Alternatively, install the Microsoft SQL Server Express on the computer that will be used as the AxTrax server.

**Note:**

Do not install the SQL server for AxTrax Client installations. AxTrax Clients connect to the AxTrax Server database.

3.2 **Starting the AxTrax Installer**

Install the AxTrax AS-525 Access Control System using the installation CD-ROM.

**To begin installing the AxTrax AS-525:**

1. Insert the CD into your computer’s CD drive.
2. Open My Computer, double-click on the CD drive icon and then double-click the AxTrax AS-525 setup file.

   If the setup detects a previous version of Axtrax AS-525, a prompt will appear asking if you want to upgrade Axtrax AS-525 to the newer version. Note that upgrading to the newer version will only use current database information. Downloading of panel information is required after upgrading the Axtrax AS-525 version.

   If there is no SQL server installed, the Installation Requirements window opens.
3. Click **Install**.

If there is no SQL server installed, the following dialog appears: “Axtrax AS-525 optionally uses Microsoft SQL Server 2005 Express. Would you like to install it now?”

If you are installing AxTrax Client or if there is already an SQL server available on the computer network, click **No**.

Otherwise, click **Yes** to install SQL Server Express.

**Note:**

Install AxTrax Server on the computer that will connect to the Access control panels and manage the database.
Install AxTrax Client on any additional computers.

4. If the Microsoft .NET 2.0 Framework is not installed on the computer, the following dialog appears: “Axtrax AS-525 optionally uses Microsoft ® .NET 2.0 Framework. Would you like to install it now?”

Click **Yes** to install Microsoft .NET Framework.

Follow the on-screen instructions to complete the installations.

### 3.3 Installing AxTrax AS-525

After the installer has added any pre-requisite software to the system, the AxTrax AS-525 Install Shield Wizard installs the software.
To Install AxTrax AS-525:

1. Wait while AxTrax AS-525 prepares to install.
   The Welcome to the Install Shield Wizard window opens.

   ![Figure 3: Welcome to the Install Shield Wizard window](image)

2. Click **Next**
   The Select Database Server window opens.
3. Select the database server name.
   On AxTrax Client installation it is likely that the database server was
   installed on another PC, click **Browse** to select the database server
   location.

4. If the database server used was installed from Veritrax setup program
   ("SQL Server express") than the instance name "\Veritrax" should be
   added to the database computer name.

5. Set the "Connect using" to the default option ("Server authentication
   using the login ID and password below") The only condition for
   setting "Windows authentication" is when using existing SQL database
   NOT installed from Veritrax setup, and only if it was installed using
   Windows authentication.

6. Click **Next**
   The Setup Type window opens.
7. To install AxTrax Server, select **Server** from the list.
   - Or -
   To install AxTrax Client, select **Client** from the list.

**Note:**
AxTrax must be first installed as AxTrax Server. Installing AxTrax Clients is optional. It can be useful for monitoring the system from more than one PC.

8. Click **Next**
   The Destination Folder window opens.

**Figure 5: Custom Setup window**

**Figure 6: Destination Folder window**
9. To select a new destination folder for AxTrax AS-525, click **Change** and browse to the required folder.

10. Click **Next**.

    The Ready to Install window opens.

![Figure 7: Ready to Install window](image)

11. Click **Install**.

    The installation process begins.

![Figure 8: Installing AxTrax AS-525 window](image)

12. When the installation is complete, the Install Shield Wizard Completed window opens.
13. Click Finish and restart the computer if requested.

During Server installations, a dialog appears while the HASP key protection software is installed.

The AxTrax AS-525 Access Control System is now fully installed on the computer.

3.4 Firewall Settings

Internal firewall settings may prevent the AxTrax Server connecting to the SQL database or to panel control units using TCP/IP. For more information on how to configure a firewall, see Firewall Configuration, page 85. Contact your system administrator or Rosslare Technical Support for further guidance.

3.5 Camera Installation & Requirement Steps

AxTrax AS-525 can connect with single or multiple ViTrax Servers installed in a LAN or WAN configuration (up to 10 ViTrax Servers are supported).

**Note:**

Make sure to check AxTrax AS-525 and ViTrax version compatibility.

To Install ViTrax Server and Client applications, refer to the ViTrax Software manual.
**Note:**

When installing the AxTrax AS-525, make sure that the ViTrax Server has already been installed on the same PC (no license required for that ViTrax Server).

**To Install Cameras:**

1. Activate ViTrax Server and Client (see ViTrax Software manual).
2. Define ViTrax Servers (see 58).
3. Define communication of AC-525 cameras to the ViTrax Server (see Defining communication of AC-525 cameras to the ViTrax Server).
4. Activate AxTrax AS-525 and configure it (see System Overview and How to Set Up a Site).
4. System Overview

The AxTrax AS-525 is controlled through an easy to use interface, with a tree-view list of all aspects of the site set-up and a toolbar for standard operations.

4.1 Starting the Software

This section explains how to start the software and login to the main window.

To start the AxTrax AS-525:

1. Click on the AxTrax AS-525 icon on the desktop, or select the program from the Rosslare folder in the Start menu.

   ![AxTrax AS-525 Access Control System Icon]

   Figure 10: AxTrax AS-525 Access Control System Icon

   The AxTrax Software login dialog appears.

   ![AxTrax Software Dialog box]

   Figure 11: AxTrax Software Dialog box

2. Select an Operator name and enter a password.

   ![Note]

   By default, the Administrator operator password is "admin". The SW versions in the screenshots are exemplary only.

3. Click **OK**

   The main AxTrax AS-525 window opens.
4.2 The AxTrax AS-525 Main Window

All the central functionality of the AxTrax AS-525 is available from its main window.

![AxTrax AS-525 Main window](image)

**Figure 12: AxTrax AS-525 Main window**

The AxTrax AS-525 Main window is divided into five sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 Menu Bar</strong></td>
<td>Controls the general operation and set-up of the software. For more information, see Menu Bar, page 19.</td>
</tr>
<tr>
<td><strong>2 Toolbar</strong></td>
<td>Use the toolbar icons for the key tasks required in managing access control across a facility. The available icons change according to the view selected. For more information, see Toolbar, page 20.</td>
</tr>
<tr>
<td><strong>3 Tree View</strong></td>
<td>The tree view allows users to configure, monitor and control every aspect of a facility access control. For more information, see Tree View, page 22.</td>
</tr>
<tr>
<td><strong>4 Display Area</strong></td>
<td>Displays all items within the tree view selected element.</td>
</tr>
<tr>
<td><strong>5 Status Bar</strong></td>
<td>Displays general status information such as: Operator name, client or server mode, system readiness, system download, date and time.</td>
</tr>
</tbody>
</table>
4.3  Menu Bar

The menu bar controls the general operation and set-up of the software.

File Menu

The File menu has four options:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon</td>
<td>Log on to the AxTrax AS-525 system. When you log on as a new Operator, the</td>
</tr>
<tr>
<td></td>
<td>previous Operator will be logged out.</td>
</tr>
<tr>
<td>Logoff</td>
<td>Close the current Operator account. The AxTrax software is minimized to the</td>
</tr>
<tr>
<td></td>
<td>taskbar.</td>
</tr>
<tr>
<td>SQL Server Logon</td>
<td>Log on to the SQL database server.</td>
</tr>
<tr>
<td>ViTrax Server</td>
<td>Log on to the ViTrax server.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the AxTrax AS-525 software.</td>
</tr>
</tbody>
</table>

Tools Menu

Use the Tools menu to manage the database and set software preferences. The menu has three options:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Open the Database window to backup the database or set a scheduled backup and to import or</td>
</tr>
<tr>
<td></td>
<td>export the AxTrax AS-525 and/or Veritrax AS-215/AS-225 configuration states and Events logs.</td>
</tr>
<tr>
<td>Options</td>
<td>Set software options and preferences, including national holidays, event highlighting, pop-</td>
</tr>
<tr>
<td></td>
<td>up alarms, custom user information fields and Reports settings.</td>
</tr>
<tr>
<td>Import Data</td>
<td>Import user information from an Excel spreadsheet file.</td>
</tr>
</tbody>
</table>

Help Menu

The help menu has one option:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Software version information.</td>
</tr>
</tbody>
</table>
4.4 Toolbar

The toolbar controls key tasks required to manage access control across a facility. When a new element is selected from the tree view, the toolbar icons change to suit the selected element. The following toolbar icons are available:

### General Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Door Manually" /></td>
<td>Open Door Manually</td>
<td>Opens the Door Manual Operation window. See Controlling the Door Manually, page 65.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Send the current display area view to the printer.</td>
</tr>
<tr>
<td><img src="image" alt="New" /></td>
<td>New</td>
<td>Create a new element of the selected type.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Edit</td>
<td>Edit the selected element.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td>Delete the selected item.</td>
</tr>
<tr>
<td><img src="image" alt="Delete All" /></td>
<td>Delete All</td>
<td>Remove all users or cards from the selected list.</td>
</tr>
</tbody>
</table>

### Events Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>Pause</td>
<td>Pause the display of events in the display area. New events will be shown again when the Pause button is clicked a second time.</td>
</tr>
<tr>
<td><img src="image" alt="View Events within the last Hour" /></td>
<td>View Events within the last Hour</td>
<td>Displays all Events that occurred within the last hour. Click the drop-down arrow to change the view.</td>
</tr>
<tr>
<td><img src="image" alt="View Events within the last Day" /></td>
<td>View Events within the last Day</td>
<td>Displays all Events that occurred within the last day. Click the drop-down arrow to change the view.</td>
</tr>
<tr>
<td><img src="image" alt="View Events within the last Week" /></td>
<td>View Events within the last Week</td>
<td>Displays all Events that occurred within the last week. Click the drop-down arrow to change the view.</td>
</tr>
<tr>
<td><img src="image" alt="View Periodical Events" /></td>
<td>View Periodical Events</td>
<td>Displays all Events that occurred within a selected period. Click the drop-down arrow to change the view.</td>
</tr>
</tbody>
</table>
### System Overview

<table>
<thead>
<tr>
<th>View All Events</th>
<th>Displays all Events. Click the drop-down arrow to change the view.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antipassback Forgive</td>
<td>Opens the Antipassback Forgive window, allowing the operator to cancel an antipassback restriction for the selected user.</td>
</tr>
<tr>
<td>Show User</td>
<td>Opens the User window for the selected user.</td>
</tr>
<tr>
<td>Clear Alarm</td>
<td>Opens the Alarm Details window, allowing the operator to reset the alarm.</td>
</tr>
<tr>
<td>Archive</td>
<td>Opens Archive Camera Window for the selected Video Stream.</td>
</tr>
</tbody>
</table>

### Networks Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Update Firmware]</td>
<td>Update Firmware</td>
<td>Send a firmware update to the selected access control panel.</td>
</tr>
<tr>
<td>![One Reader per Door]</td>
<td>One Reader per Door</td>
<td>Displays new panel with single reader per door (with/without extension panel). See Adding Access Control Panels, page 29.</td>
</tr>
<tr>
<td>![Two Readers per Door]</td>
<td>Two Readers per Door</td>
<td>Displays new panel with two readers per door (with/without extension panel). See Adding Access Control Panels, page 29.</td>
</tr>
<tr>
<td>![Set Time]</td>
<td>Set Time</td>
<td>Set the time on the selected Access Control Panel. See Setting the Time and Date, page 73.</td>
</tr>
<tr>
<td>![Find Panels]</td>
<td>Find Panels</td>
<td>Find and update panels within the network. See Detecting Panels Automatically, page 73.</td>
</tr>
<tr>
<td>![Modem Manual]</td>
<td>Modem Manual</td>
<td>Opens the Modem Status window, allowing the operator to connect or disconnect the modem and change the connection password.</td>
</tr>
<tr>
<td>![Camera]</td>
<td>Camera</td>
<td>View a list of camera’s connected and assign camera’s to panels, page 60.</td>
</tr>
</tbody>
</table>

### Panel Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
### Control Output
Manually
Change the settings for the outputs on the selected panel. See Controlling Outputs Manually, page 67.

### Control Input
Manually
Change the settings for the inputs on the selected panel. See Manually Disarming Inputs, page 68.

### Control Siren
Manually
Test the siren for the selected panel. See Testing the Siren, page 69.

### Manually Download new Panel Data
Update the selected panel. See Manual Download of Panel Data, page 74.

### Manually Download failed Data
Downloads the entire Panels Failed database. See Downloading Failed Data: page 75

### Departments\Users Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Find Users</td>
<td>Search for a user in the database.</td>
</tr>
<tr>
<td></td>
<td>User Counter</td>
<td>View current User count value. See Testing User Counters: page 76</td>
</tr>
</tbody>
</table>

### Reports Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Produce Report</td>
<td>Produce the selected report.</td>
</tr>
</tbody>
</table>

### 4.5 Tree View

The Tree View allows users to configure, monitor and control every aspect of a facility's access control network. When the user selects an element from the tree, its contents are shown in the main display area and the toolbar icons change to suit the selected element.

### Events

The Events log displays a log of every time access was granted or denied, for every door on a site. Monitoring for potential door tampering or forced entry, is logged and displays of internal system warnings, including Video stream archive are saved to the ViTrax database.
Status Map

The Status Map displays the status of every door, reader and alarm in the facility on user-selected floor plans. The system can display multiple nested status maps, allowing users to show either the complete access control network or a specific area in detail. For more information, see Creating Status Maps, page 55.

Networks

A network is a group of up to 32 access control panels. The AxTrax Server connects to the panels across the panel network. The AxTrax AS-525 can support up to 1023 panel networks. For more information, see Defining a Network, on page 27.

Note:

To work with 65 panels or more, a HASP security key must be connected to the AxTrax Server machine. See System Requirements, page 8.

Time Zones

Defines a weekly time period or set of time periods, for example, "Office Hours" or "Out of Office Hours". Door access rights, alarms and input and output behavior can all be set to behave differently within each Time Zone. For more information, see Defining Time Zones, page 24.

Access Groups

An Access Group defines when each reader on the site will be available for access. All site personnel are assigned to appropriate Access Groups. For more information, see Creating Access Groups, page 41.

Input and Output Groups

Input and output groups defines sets of outputs or inputs that should be managed together within a panel. For more information, see Configuring the Inputs, page 39.

Access Areas and Global Antipassback

A facility can be sub-divided into several access areas in order to configure and manage it more effectively. Antipassback rules can be applied for each access area to prevent one user's card or entry code being used for two subsequent entries and to prevent a second

entry without a previous exit. For more information, see 6. Enter details for the user and click **OK**.

7. Click "New User" from within user tab to add new users.
8. The window closes and the display area displays the user.

Creating Access Areas and Global Antipassback Rules, page 50.

**Cards**

Every user can be assigned a PIN and one or more cards. For more information, see Defining Cards, page 43.

**Departments and Users**

Every user is a member of a department. It is possible to store additional access rights, personal details and an identification photograph for each user. For more information, see Defining Users and Departments, page 44.

**Holidays**

Defines annual holiday dates. Using Time Zones, it is possible to set special access behaviors for holiday time.

![Note:](image)

Selected holiday dates can also be imported into the AxTrax AS-525 from Microsoft™ Outlook.

**Operators**

Operators are people with access to the AxTrax software. The default operator names are administrator, engineer and security. Different operators have wider or more restricted security rights, from complete control over the system to the ability only to view one section. All Operator passwords are case-sensitive.

**Reports**

AxTrax can produce various reports, including usage reports, attendance records and roll calls. The AxTrax Report Wizard allows users to design their own custom reports, based on their needs. For more information, see Reports, page 71.
### How to Set Up a Site

This section outlines a suggested step-by-step process for configuring the AxTrax AS-525 for a site.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Define a Network.</td>
<td>See Defining a Network, page 27.</td>
</tr>
<tr>
<td>3</td>
<td>Define and Configure an Access Control Panel.</td>
<td>See Adding Access Control Panels, page 27.</td>
</tr>
<tr>
<td>4</td>
<td>Configure the Doors.</td>
<td>See Setting Door Properties, page 35.</td>
</tr>
<tr>
<td>5</td>
<td>Configure the Readers.</td>
<td>See Configuring the Reader, page 36.</td>
</tr>
<tr>
<td>6</td>
<td>Configure the Inputs.</td>
<td>See Configuring the Inputs, page 39.</td>
</tr>
<tr>
<td>8</td>
<td>Define new Cards.</td>
<td>See Defining Cards, page 43.</td>
</tr>
<tr>
<td>9</td>
<td>Set-up new Users.</td>
<td>See Defining Users and Departments, page 44.</td>
</tr>
<tr>
<td>10</td>
<td>Define Access Areas and Antipassback.</td>
<td>See 6. Enter details for the user and click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. Click &quot;New User&quot; from within user tab to add new users.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. The window closes and the display area displays the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Creating Access Areas and Global Antipassback Rules, page 50.</td>
</tr>
<tr>
<td>12</td>
<td>Configure a Status Map.</td>
<td>See Creating Status Maps, page 55.</td>
</tr>
</tbody>
</table>

The AxTrax AS-525 system performs automatic data download for any parameter related to the hardware. If panels are connected and active,
"Downloading" will appear on the status bar after any downloaded parameter change. "Ready" appears when download is complete, however it may also appear after a failed download.

**Note:**

It is the operators' responsibility to verify that the download operation succeeded or failed. This can be verified in the system event list or by checking the download failed data manually, see page 75.

### 5.1 Defining Time Zones

A time zone is a group of periods within a week. Door access rights, alarms and input and output behavior can all be set to behave differently for each Time Zone. Many operations can automatically enable or disable within a selected time zone.

The Time Zone Properties window displays the selected periods for each day in the week. It is possible to set a maximum of eight different periods.

**To set a new time zone:**

1. Select Time Zones from the tree view.

   Click the **New** icon on the toolbar. The Time Zones Properties window opens.

   ![Figure 13: Time Zone Properties window](image)

   **Figure 13: Time Zone Properties window**
How to Set Up a Site

The Time Zone Properties window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a name for the time zone.</td>
</tr>
<tr>
<td>Start / End</td>
<td>Enter a start time and an end time for each period.</td>
</tr>
<tr>
<td>Sun–Hol</td>
<td>Select the days on which the time period is within the time zone. The &quot;Holiday&quot; day can be set to include national holidays.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clear all the time zone settings.</td>
</tr>
</tbody>
</table>

2. Enter a name for the time zone and set the required time periods. Click **OK**.  
The window closes and the display area displays the new time zone.

**Note:**  
Time settings can be copy-and-pasted between time zones. Right-click on a time zone and select **Copy** from the shortcut menu then Right-click on a second time zone and select **Paste** from the shortcut menu.

5.2 Defining a Network

The AxTrax AS-525 communicates with each access control panel as part of a network. A network is a group of up to 32 access control panels. The Network window includes the following information:

- The network's name, address and status
- The DIP switch settings for the communication speed
- The type of network connection and the connection settings

To access the network window:

1. In the Tree view, click Networks, and from the **Network** toolbar, click **New**.  
The Network window is displayed.
The Network window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a name for the network. The network address for the network is shown to the right of the network name.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Enable the checkbox when the network is connected and operational.</td>
</tr>
<tr>
<td>Network Type</td>
<td>Select the Network type: Serial, TCP/IP or Modem. See Network Configuration, on page 90.</td>
</tr>
<tr>
<td>Serial / TCP/IP / Modem Network</td>
<td>Set the connection type and speed. For TCP/IP connections, set the IP Address. See Network Configuration, on page 90.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Opens the Configuration window to set communication preferences. This button appears when selecting a Modem or TCP/IP LAN network. For more information, see Network Configuration, page 90.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Sets the Maximum Communication timeout for panel response time; Set to “Slow” if panel response is not consistent. This condition may occur due to busy TCP/IP network or when connecting panels on a WAN in remote sites</td>
</tr>
</tbody>
</table>
2. Enter a name for the new Network in the Description box and select the Enabled check box. Select the Network type and set the connection settings.

3. For a Modem, click the Configuration button to set dialing preferences for the computer's modem and the receiving modem.

4. For a TCP/IP LAN, click the Configuration button to locate the hardware on the local network.

For more information on how to configure an access control network, see Network Configuration, page 90. Check with your system administrator for more information, or contact Rosslare technical support (see Technical Support, page 97). Un-check the "Enabled" checkbox if you wish to pause communication to panels on the network.

Note:

Access control panels connect to a TCP/IP network via a MD-N32 TCP to Serial converter or using the on board converters in AC-225 or AC-525. Refer to the relevant hardware installation guides for more details.

5. For all types of network, set the DIP switch on the Access control panel hardware to match the diagram at the top of the screen.

Note:

Make sure to power-down and then power-up the panels after changing DIP switch.

5.3 Adding Access Control Panels

Every network is a cluster of access control panels. Each Panel can be configured using two readers per door when the door acts as both the entrance and exit to an area of the site. In their standard form, each access control panel unit has two readers and it can be configured as either as single door with two readers or as two doors with one reader per each door. When using optional MD-D02 readers expansion board (supported by AC-225 or AC-525) each panel will have four readers and can be configured as four doors panel. Use two readers per door when one door acts as both the entrance and exit to an area of the site. When only an entry reader is required, use one reader per door.

For example:

- Use configuration with two readers per door set to IN and OUT, to produce attendance reports.
- Use one reader per door configuration to control two doors with "IN" reader only (exiting the premises will be by REX switch or by mechanical door handle only).
General Panel Settings

The General tab of the Door Controller Panel Properties window displays the following:

- The panel's address and status
- The DIP switch settings for the panel

If panel expansion boards are installed:
- The input and output connections for the panel
- The panel's hardware version

Refer to AC-525 Hardware manual for further details on panel configurations.

To add a panel:

1. In the tree view, click on Networks. The available networks are listed in the display area.

2. Select a network.
   - For one reader per door on the Access Control Panel, click the **One Reader per Door** icon.
   - For two readers per door on Access Control Panel, click the **Two Reader per Door** icon.

**Note:**
Make sure that Dip Switch 3 position on the panel corresponds with it's position demonstrated on the panel properties window. The Door Controller Panel Properties window opens.
### Figure 15: Door Controller Panel Properties window

The Door Controller Panel Properties window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Panel Address</strong></td>
<td>Enter an address number for the panel.</td>
</tr>
<tr>
<td></td>
<td>The network's address is displayed to the left of the panel address. Valid entries are 1-32.</td>
</tr>
<tr>
<td><strong>Hardware Version</strong></td>
<td>Select the appropriate panel hardware type.</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the checkbox to activate this panel.</td>
</tr>
<tr>
<td></td>
<td>Clear the checkbox if the panel is not connected.</td>
</tr>
<tr>
<td><strong>Upload Previous Events</strong></td>
<td>Enable the checkbox to send previous logged events from the panel.</td>
</tr>
<tr>
<td><strong>Inputs</strong></td>
<td>Displays the input connections for the panel.</td>
</tr>
<tr>
<td><strong>Outputs</strong></td>
<td>Displays the output connections for the panel.</td>
</tr>
</tbody>
</table>
How to Set Up a Site

### Test

Click to test the panel is correctly connected to the computer.

The Test Panel window displays hardware details including hardware type, firmware and bootloader versions, and indicates whether an I/O expansion board is installed on the panel.

3. Select the appropriate Hardware Version for your panel.

   Ensure that the DIP switch on the panel matches the diagram at the top of the screen.

   Click **OK**. The window closes and the display area displays the new Panel.

   **Note:**

   After a panel is connected, AxTrax AS-525 can also detect and add it automatically. For more information, see Detecting Panels Automatically, page 73.

### Configuring the Panel

Each panel has individual settings for antipassback behavior and for recording events.

Once the panel is connected, configure a panel's options from the Options tab in the Door Controller Panel Properties window.

   **Note:**

   When there is communication with the panel the Tx and Rx LEDs flash.

**To configure a panel:**

1. In the tree view, click on Networks.

   The available networks are listed in the display area.

2. Expand a network in the tree view and select a panel to configure.

   Click on the **Edit** icon. The Door Controller Panel Properties appears.
Figure 16: Door Controller Panel Properties Options tab

The Options tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>Select the time zone for door antipassback rules to apply.</td>
</tr>
<tr>
<td>Antipassback</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
The Door Antipassback feature is now available for four doors. To activate Antipassback you must check the IN Reader / OUT Reader check-box next to the appropriate reader/s.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard</td>
<td>When hard antipassback is selected, an event is generated and the door does not open.</td>
</tr>
<tr>
<td>Soft</td>
<td>When soft antipassback is selected, the door opens but an event is generated.</td>
</tr>
<tr>
<td>Reader 1-4</td>
<td>Enable the checkboxes to apply antipassback restrictions to Reader 1 thru Reader 4 as required. Only when the check-box is checked is the reader Antipassback enabled.</td>
</tr>
</tbody>
</table>
Select
Open the Events Filter and select the Events this Panel should record.

Set the filter's operation method:

- **Always Active**: Only the selected events are recorded by the panel.
- **Active when disconnected**: If the panel is disconnected from the AxTrax server, only the selected events are recorded. When the panel is connected to the server, all event are recorded.

Note: In default configuration, some events are filtered and may not be seen in display area - events view.

3. Click on the Options tab.
4. Set antipassback and event filtering for this panel and click **Test**.

The test screen displays the following information:

![Figure 17: Panel Connection Test](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firmware version</strong></td>
<td>The firmware version of the board.</td>
</tr>
<tr>
<td><strong>Bootloader version</strong></td>
<td>The bootloader version of the board.</td>
</tr>
<tr>
<td><strong>Hardware</strong></td>
<td>The hardware name.</td>
</tr>
<tr>
<td><strong>Supervised Inputs</strong></td>
<td>The panel is secure in case of tampering.</td>
</tr>
<tr>
<td><strong>MD-I084</strong></td>
<td>MD-I084 does or does not exist</td>
</tr>
<tr>
<td><strong>MD-D02</strong></td>
<td>MD-D02 does or does not exist</td>
</tr>
</tbody>
</table>

5. Click **OK**.

The window closes and the display area displays the new Panel.

**Note:**
A panel configuration can be copied-and-pasted between
5.4 Setting Door Properties

Every Panel controls one or two doors, or four doors if MD-D02 reader extension board is connected. Each door can be configured individually. The Door Controller Properties window displays the following:

- The settings for unlocking and re-locking
- The time available before the door relocks or records alarm events

To set door properties:

1. In the tree view, click on Networks. The available networks are listed in the display area.
2. Select a network and expand a panel in the tree view. Select a door to set its properties.
3. Click on the Edit icon. The Door Controller Properties Window opens.

![Figure 18: Door Properties window](image-url)
The Door Properties window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a name for the door.</td>
</tr>
<tr>
<td>REX enabled</td>
<td>A Request to Exit unlocks the door for a user-defined duration. Enable the checkbox to allow Requests to Exit for this door. The door REX inputs locations depend on panel configurations, they can be seen in the panel properties window.</td>
</tr>
<tr>
<td>First person delay on automatic unlock</td>
<td>Sets the door's behavior during an automatic unlock time zone. Enable the checkbox to require that during the selected Time Zone the door remains unlocked only after the first user opens it. The automatic unlock time zone is selected in Panel Links Window by selecting the output corresponding to that door. See Setting Panel Links, page 53.</td>
</tr>
<tr>
<td>Door output polarity is Normal Closed</td>
<td>Enable this checkbox to ensure fail Safe door opening if the Fail Safe door Lock Device power fails. Once enabled, the door output relay will activate when the door is closed and de-activate when door is open. In this configuration, the Fail Safe lock device should be wired to the door relay N.O (Normal Open) and COM (Common) terminals.</td>
</tr>
<tr>
<td>Manual Door Open Enabled</td>
<td>Enable this checkbox to allow operators to adjust the door manually. See Controlling the Door Manually, page 65.</td>
</tr>
<tr>
<td>Door open time</td>
<td>Set the duration for which the door stays unlocked.</td>
</tr>
<tr>
<td>Extended door open time</td>
<td>Set the duration for which the door stays unlocked for users with Extended door open rights.</td>
</tr>
<tr>
<td>Door held open</td>
<td>Set the duration for which the door can be held open without raising an event. Enable the checkbox to use this timer.</td>
</tr>
<tr>
<td>Door Forced Open</td>
<td>Set the duration after which when the door is forced an event occurs. Enable the checkbox to use this timer.</td>
</tr>
</tbody>
</table>

4. Configure the door as required and click **OK**

5.5 Configuring the Reader

A panel can be connected to two readers, or four readers when MD-D02 extension board is connected.

The reader properties window has two tabs:
How to Set Up a Site

- The General tab sets general operation settings for the reader
- The Options tab sets access options for the reader

To configure a Reader:

1. In the tree view, click on Networks.
   The available networks are listed in the display area.
2. Select a network and expand a panel in the tree view.
   Expand a door within the panel and select a reader to set its properties.
   Click on the Edit icon.
   The Reader Properties Window opens.

General Reader Operation Settings

The Reader Properties General tab displays:
- The settings for how the reader will operate
- The type of reader that is being used

Figure 19: Reader Properties General tab

The Reader Properties General tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter the name of the reader.</td>
</tr>
</tbody>
</table>
Field Description

**Operation Mode**
Select how the reader operates.
- **Inactive**: The reader is not in use.
- **Card Only**: The reader will accept RFID cards only.
- **PIN Only**: The reader will accept PIN inputs only.
- **Card or PIN**: The reader will accept both cards and PINs.
- **Desktop**: The reader is inactive, but being used to record new cards on the computer.
- **No Access Mode**: The reader will not grant access to any users.

**Direction**
Select whether in the reader is allowing access into the area or exit out of it.

**Secured (Card+PIN) time zone**
Select a time zone during which access should be granted only after both the card and PIN are entered.
The PIN must be entered within 10 seconds of the card.

**Activation**
Enable the checkbox to allow the reader to unlock the door.

**Deduct User Counter**
Enable the checkbox to record this entry against the user's entry allowance counter.
See General User Properties, page 45.

**Reader type**
Select the data transmission type for the reader hardware.

**Keypad type**
Select the data transmission type for the type of keypad hardware.

**Check facility code only**
Enable the checkbox to allow access to any user assigned to a facility listed in the selected list of facilities.
The list of facilities is defined on the Options tab.

**AYC-W6500 Biometric Reader**
Enable the checkbox to interface with the AYC-W6500 biometric reader and its PC application.

3. Configure the reader as required and click **OK**

**Reader Access Options**

The Reader Properties Options tab displays:
- **Timed antipassback settings** for the reader
- **Restricted site access settings**
Figure 20: Reader Properties Options tab

The Reader Properties window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic Antipassback</strong></td>
<td>Select the time zone in which timed antipassback rules apply. To set Time Zones, see Defining Time Zones, page 26.</td>
</tr>
<tr>
<td><strong>Hard</strong></td>
<td>When hard antipassback is selected, an event is generated and the door does not open.</td>
</tr>
<tr>
<td><strong>Soft</strong></td>
<td>When soft antipassback is selected, the door opens but an event is generated.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Set the number of minutes before a user can re-enter using this reader.</td>
</tr>
<tr>
<td><strong>Add from List</strong></td>
<td>Click to add sites from a list. The site list applies only when the Check site code only checkbox on the General tab is enabled.</td>
</tr>
<tr>
<td><strong>Add Manually</strong></td>
<td>Click to enter a site code. The site list applies only when the Check site code only checkbox on the General tab is enabled.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Remove the selected site from the list.</td>
</tr>
</tbody>
</table>

4. Configure the reader as required and click **OK**.
5.6 Configuring the Inputs

Every panel has four inputs. Using MD-I084 adds another eight inputs (12 inputs total) and using MD-D02 adds four inputs (8 inputs total). Some inputs are dedicated and some are general purpose inputs. The panel properties window displays the settings for each input. Input type is programmed individually no matter if it is a dedicated input or general purpose input.

To configure an Input:

1. In the tree view, click on Networks.
   The available networks are listed in the display area.
2. Select a network and expand a panel in the tree view.
   Select Inputs and select an input from the display area.
3. Click on the Edit icon.
   The Input Properties Window opens.

![Figure 21: Input Properties window](image)

The Panel Properties window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a name for the input.</td>
</tr>
</tbody>
</table>
How to Set Up a Site

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of input to be monitored.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normally Open/Close</strong>: An input either in an open or close state.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normally Open/Close 1 Resistor</strong>: An input in an open, close or trouble state. This option is only available for supervised inputs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normally Open/Close 2 Resistor</strong>: An input in an open, close or trouble state, with additional checks for short-circuit and open-circuit tampering. This option is only available for supervised inputs.</td>
</tr>
<tr>
<td></td>
<td>For more information, please refer to the access control panel hardware manual.</td>
</tr>
<tr>
<td><strong>Activity start delay</strong></td>
<td>Set the delay time before this input becomes active. Note that on normally open input, the delay starts once the input contact is closed. On normally closed input, the delay starts once the input contact opens.</td>
</tr>
</tbody>
</table>

4. Configure the input as required and click **OK**

### 5.7 Creating Access Groups

An access group is a list of door readers and of time zones during which each of those door readers are available for access. Every user is assigned to an access group. The Access Group window lists all the door readers defined in the database and the time zones during which they can be accessed.

**To create an access group:**

1. Expand the Groups element in the tree view and select Access Groups. Click the **New** icon on the toolbar. The Access Groups window opens.
The Access Group window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a name for the access group.</td>
</tr>
<tr>
<td>Reader</td>
<td>Lists every reader defined in the database.</td>
</tr>
<tr>
<td>Group time zone</td>
<td>Select the time zone during which this reader should be accessible.</td>
</tr>
</tbody>
</table>

2. Enter a name for the access group and set time zones for readers as required. Click **OK**.
   The window closes and the display area displays the new access group.

**Note:**
Access settings can be copy-and-pasted between access groups. Right-click on a access groups and select **Copy** from the shortcut menu. Right-click on a second access group and select **Paste** from the shortcut menu.
5.8 Defining Cards

The AxTrax database maintains a list of every user card or PIN that has been assigned. The Add Cards window defines:

- The type of reader needed to read the card
- The number of cards to create
- If users should be created in the database for each new card

To Define Cards:

1. Select Cards in the tree view.

   Click the **New** icon on the toolbar.

   The Add Cards window opens.

   ![Add Cards window](image)

   **Figure 23: Add Cards - Manual tab**

   The Add Cards – Manual tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reader Type</strong></td>
<td>Select the type of reader appropriate for these cards.</td>
</tr>
<tr>
<td><strong>Cards quantity</strong></td>
<td>Enter the number of cards to add.</td>
</tr>
<tr>
<td><strong>Start from</strong></td>
<td>Enter the card number for the first card in the set.</td>
</tr>
<tr>
<td><strong>Facility code</strong></td>
<td>Enter the site code for these cards. This field is not available for all reader types.</td>
</tr>
<tr>
<td><strong>New Users</strong></td>
<td>Enable this checkbox to create a new user in the database for each new card.</td>
</tr>
</tbody>
</table>
### How to Set Up a Site

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Number started from</strong></td>
<td>Enter the user number for the first user in the set. This field is only available when the New Users checkbox is enabled. A maximum of 1000 users can be generated at one time.</td>
</tr>
</tbody>
</table>

2. Set fields as required and click **Add**. A dialog reports that the operation has been completed.

### 5.9 Enrolling cards using MD-08

This option is available for users with the MD-08 unit on-board.

**To Define MD-08:**

1. Select Cards in the tree view.
   - Click the **New** icon on the toolbar. The Add Cards window opens (see Figure 23).

2. Click the MD-08 tab. The MD-08 tab is displayed.

3. Select your Reader type, and then Com Port.

4. Click **Add**.

![Figure 24: Add Cards- MD-08 tab](image)
5.10 Defining Departments and Users

Every user is grouped within a department. The AxTrax AS-525 stores contact details for each user, associated card details and user access rights.

The User Properties window has four tabs:

- General tab displays identification and control information
- Codes tab displays information about cards associated with the user
- Details tab records user contact details
- User Fields tab stores user-defined data

To create departments:

1. Select the Departments\Users element in the tree view.

2. To create a new Department, click the New icon on the toolbar. The Departments dialog appears.

![Department dialog](image)

Figure 25: Department dialog

3. Enter a name for the department and click OK.

4. Expand the Departments\Users element and select a Department for the new user.

5. Click the New icon on the toolbar. The User Properties window opens.

General User Properties

The General tab displays:

- User identification information
- User validity settings
- Access rights for the user
### Figure 26: Department dialog

The General tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add/Remove</td>
<td>Click to add a photo of the user, or to remove an existing photo. Note that the selected photo aspect ratio should be 1.25 H x 1.00 L otherwise the photo may be distorted.</td>
</tr>
<tr>
<td>First name</td>
<td>Enter the user's first name.</td>
</tr>
<tr>
<td>Middle name</td>
<td>Enter the user's middle name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Enter the user's last name.</td>
</tr>
<tr>
<td>User number</td>
<td>Enter a unique user number to identify the user.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the user's department.</td>
</tr>
<tr>
<td>Access group</td>
<td>Select the user's access group.</td>
</tr>
<tr>
<td>Select color</td>
<td>Click to select which color to use to highlight this user when access events generated by that user. User highlighting must be activated in Tools &gt; Options &gt; General tab.</td>
</tr>
<tr>
<td>Location</td>
<td>Click to display a log of doors accessed by this user.</td>
</tr>
</tbody>
</table>
### How to Set Up a Site

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Valid date from</strong></td>
<td>Enter the date from which the user's access rights begin.</td>
</tr>
<tr>
<td><strong>Valid date until</strong></td>
<td>Enable the checkbox to set the date on which the user's access rights end.</td>
</tr>
<tr>
<td><strong>(checkbox)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Valid date until (field)</strong></td>
<td>Enter the date on which the user's access rights end. This field is only available when the checkbox has been enabled.</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the checkbox to set an access rights countdown counter for this user. When the counter reaches zero, the user's access rights end.</td>
</tr>
<tr>
<td><strong>Test</strong></td>
<td>Click to check the current state of the user's countdown counter.</td>
</tr>
<tr>
<td><strong>Set new counter</strong></td>
<td>Enable the checkbox to set a new countdown counter value for this user.</td>
</tr>
<tr>
<td><strong>(checkbox)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Set new counter (field)</strong></td>
<td>Enter a new countdown counter value for this user. This field is only enabled when the Set new counter checkbox has been enabled.</td>
</tr>
<tr>
<td><strong>Rights</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Antipassback immunity</strong></td>
<td>Enable the checkbox to override any antipassback restrictions for this user.</td>
</tr>
<tr>
<td><strong>Extended door open time</strong></td>
<td>Enable the checkbox to entitle this user to an extended unlocked door duration. The extended duration is set for each door. See Setting Door Properties, page 35.</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Access Granted command</strong></td>
<td>Enable the checkbox to activate a user-defined set of inputs or outputs for this user. The operations are set in the Links window. See Setting Panel Links, page 53.</td>
</tr>
<tr>
<td><strong>Access Denied command</strong></td>
<td>Enable the checkbox to activate a user-defined set of inputs or outputs for this user. The operations are set in the Links window. See Setting Panel Links, page 53.</td>
</tr>
<tr>
<td><strong>User selected Output group</strong></td>
<td>Select an output group for this user. The outputs will be triggered every time the user accesses a door, as specified in the Links window. See Setting Panel Links, page 53.</td>
</tr>
</tbody>
</table>
### Handicapped checkbox

Enable the checkbox to activate a dedicated output a short time after the door is unlocked. The outputs are set in the Links window. See Setting Panel Links, page 53.

### Associated Cards and Codes

The Codes tab displays:

- The card codes assigned to this user
- The PIN code assigned to this user
- Biometric fingerprint templates for this user, only valid when using Rossllare’s AYC-W6500 Biometric reader and its corresponding PC application

![Figure 27: Users General tab](image)

The Codes tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Site Code</strong></td>
<td>The site code assigned to this card.</td>
</tr>
<tr>
<td><strong>Card Number</strong></td>
<td>The unique number of this card.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Select the status of the card. Inactive cards cannot gain access to the facility.</td>
</tr>
<tr>
<td><strong>Add from list</strong></td>
<td>Click to add a new card. All cards within the user's specified site code are listed.</td>
</tr>
</tbody>
</table>
How to Set Up a Site

### Field Description

<table>
<thead>
<tr>
<th><strong>Add Manually</strong></th>
<th>Click to create new cards from the Add Cards window. For more information see Defining Cards, page 43.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of digits</strong></td>
<td>Select the length of the PIN for this user.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Enter a PIN.</td>
</tr>
<tr>
<td><strong>AutoPIN</strong></td>
<td>Click to automatically generate a random PIN.</td>
</tr>
<tr>
<td><strong>Fingerprint</strong></td>
<td>Specifies if the user has recorded fingerprint templates. For use with the AYC-W6500 Biometric Reader and its corresponding PC application.</td>
</tr>
</tbody>
</table>

### User Contact Details

The Details tab records contact and identification details about the user.

![Image](image_url)

**Figure 28: Details tab**

The Details tab contains the following fields:

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Telephone</strong></td>
<td>Enter an office telephone number for the user.</td>
</tr>
<tr>
<td><strong>Mobile</strong></td>
<td>Enter a cell phone number for the user.</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>Enter a fax number for the user.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Email | Enter an email address for the user.
Address | Enter a postal address for the user.
Home telephone | Enter a home telephone number for the user.
Car registration | Enter the user's license plate number.
Title | Enter the user's title (e.g. "Mr.").
Employment Date | Enter the date the user joined the firm.
Notes | Enter any additional information.
Details | Click to open the user's additional details folder.

**User Defined Data**

The User Fields tab can be used to store any information required by the system operator.

![User Properties Window](image)

*Figure 29: User Fields tab*

- User fields are defined in Tools > Options > User Fields tab. See User Defined Fields, page 82.

6. Enter details for the user and click **OK**
7. Click "New User" from within user tab to add new users.
8. The window closes and the display area displays the user.
5.11 Creating Access Areas and Global Antipassback Rules

A large site can be divided into several smaller and more manageable access areas. Reports can be produced individually for each area. In addition, global antipassback rules can be applied for each access area. When global antipassback rules are in force, a user cannot re-enter an access area until they have left it.

**Note:**
Global antipassback functionality is only enforced when the AxTrax AS-525 is connected and monitoring the entire access control system.

Use the Access Area window to add entry and exit door readers to an area within the facility.

**To create a new access area:**

1. Expand Access Area in the tree view and select the parent area within which to add the new access area.

   Click the **New** icon on the toolbar. The Access Area window opens.

![Figure 30: Access Area window](image)
The Access Area window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the access area.</td>
</tr>
<tr>
<td>Enter to area</td>
<td>Lists the entry readers into this access area.</td>
</tr>
<tr>
<td>Exit from area</td>
<td>Lists the exit readers out of this access area.</td>
</tr>
<tr>
<td>(&lt;&lt;/ &gt;)</td>
<td>Click to add and remove readers from the Enter to Area and Exit from Area lists.</td>
</tr>
</tbody>
</table>

2. Enter a name for the access area and select entry and exit readers.
   Click **OK**.
   The window closes and the new access area displays in the display area.

3. Select Global Antipassback in the tree view and click the **New** icon on the toolbar.
   The Global Antipassback dialog appears.

   ![Global Antipassback Dialog Box](image)

   **Figure 31: Global Antipassback dialog box**

4. Enter a description for the antipassback rule and select the access area and time zone for which it applies. Select a Hard or Soft antipassback.

5. Click **OK**.
   The dialog closes and the global antipassback rule is shown in the display area.

**Note:**
Global antipassback will cause antipassback event only on "Enter" readers to the defined "Area".
To implement antipassback on Exit readers as well, it is necessary to define a new area with opposite reader directions. Readers defined "Enter" in first area need to be defined again in the new Area as "Exit" readers, and "Exit" readers in first "Area" should be defined "Enter" readers in second "Area".

5.12 Setting Panel Links

Panel Links are rules for how the system should behave when events occur in the access control panel. The Links window displays:

- An event on a panel and the panel element to which the link response applies
- The required input or output response
- Any alarm message to display on the AxTrax AS-525 computer

To create a panel link:

1. In the tree view, click on Networks. The available networks are listed in the display area.
2. Select a network and expand a panel in the tree view. Select Panel Links and select a link from the display area.

Click on the Edit icon . The Links Window opens.

![Figure 32: Links window](image-url)
The Links window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source Type</strong></td>
<td>Select the panel element type which raises the event.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Select the panel element which raises the event. Up to 8 links can be added for each source.</td>
</tr>
<tr>
<td><strong>Event</strong></td>
<td>Select the event.</td>
</tr>
<tr>
<td><strong>Event Description</strong></td>
<td>Enter a description for the event.</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the checkbox to activate this link rule.</td>
</tr>
<tr>
<td><strong>Generate Alarm</strong></td>
<td>Enable the checkbox to generate an alarm condition when the selected event occurs.</td>
</tr>
<tr>
<td><strong>Destination Type</strong></td>
<td>Select the panel element type that responds to the event.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>Select the panel element that responds to the event.</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td>Select the operation for the destination element to perform.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Enter the duration for which this operation should apply. This box is only available when a time-bound operation is selected.</td>
</tr>
<tr>
<td><strong>Time Zone</strong></td>
<td>Select the time zone during which this link rule applies.</td>
</tr>
<tr>
<td><strong>Alarm Message</strong></td>
<td>Enter a message to be displayed as an on-screen alarm when the selected event occurs. This box is only available when the Generate Alarm checkbox has been enabled.</td>
</tr>
<tr>
<td><strong>Select Color</strong></td>
<td>Click to select a color for the alarm message. This box is only available when the Generate Alarm checkbox has been enabled.</td>
</tr>
<tr>
<td><strong>Sound check-box</strong></td>
<td>Click to select Sound for Alarm; operable when Generate Alarm check-box is checked.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Browse files for the sound *.wav file you want for the Generated Alarm to sound.</td>
</tr>
<tr>
<td><strong>Sound Now button</strong></td>
<td>Click Sound Now button to generate the selected sound.</td>
</tr>
</tbody>
</table>

3. Define a link and click OK.

**Note:**
Numerous events and links can be defined in Panel Links. It is the operators' responsibility to avoid conflicting or non-logical definitions. Also, not all events sources that appear in Links.
5.13 Creating Status Maps

The Status Map displays the status of every door, input, output, antipassback rules and alarms in the facility on user-selected floor plans.

**To set-up a Status Map:**

1. In the tree view, click on Events, then click Status Map and click on the New Element icon.
   A new map element appears in the tree view.
2. Right-click on the new map element.
   A shortcut menu appears.
3. Select the **Picture** option.
   The Select Image File window opens.

   **Note:**
   To change map image and/or to add objects on the map, you must press the Pause key (see Toolbar, page 20), after which the option to right click the map name on the tree view will be enabled.

4. Select a graphic file for the Status Map background.
   The file is shown in the display area in one of the following formats: jpg, gif or bmp.
5. Ensure that the Status Map toolbar is showing the "offline mode" icon.

Click on Networks and right-click on a door, reader, input, output, panel or another status map that should be displayed as an object on the status map.

Select Add to Map from the shortcut menu.

The object appears on the status map, and can be dragged to its correct position.
How to Set Up a Site

6. Right-click on a map object to set its properties, and select **Show on Map** from the shortcut menu. The Show on Map window opens.

![Show on Map window](image)

7. Enable the Status checkbox to display the object's state on the status map.

For a door's Show on Map properties, select:

- **By Door Monitor** - show the door's open state based on its physical position.
- **By Door Output** - show the door's open state based on the status of its lock.

8. Repeat step 5–7 until all objects are shown on the status map, as required.

Repeats steps 1–7 to setup additional status maps.

**Note:** Status map icons can also be added to other status maps, indicating where the two map areas meet.
6. Vitrax Video Integration

Utilizing camera’s on your AC-525 panel is done using the following Steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connecting to Vitrax Server.</td>
<td>See Connecting to ViTrax Server, page 58.</td>
</tr>
<tr>
<td>2</td>
<td>Adding a Camera to AC-525 panel.</td>
<td>Adding a Camera to AC-525 panel, page 58.</td>
</tr>
<tr>
<td>4</td>
<td>Viewing Recorded Events.</td>
<td>See Viewing Recorded events, page 62.</td>
</tr>
</tbody>
</table>

6.1 Connecting to ViTrax Server

Define the ViTrax Server database that the AS-525 AxTrax Software communicates with.

To Connect to ViTrax Server:

1. When the ViTrax Server is running, click File/ViTrax Server. The ViTrax Servers window is displayed.

2. Click the New icon on the toolbar. The Server ViTrax window is displayed.

Figure 36: ViTrax Servers
3. In the ViTrax IP Address field, type in either Local host or other IP address name.

4. In the ViTrax User Name, type in Username.

5. In the ViTrax Password, type in Password.

**Note:**

The Password typed must resemble the non-default password for the server.

6. Click **Auto connect on Start** checkbox.

7. Click **Connect**

8. Click **OK**

   The message “ViTrax Server Connected” is displayed.

The ViTrax server now appears in the ViTrax Servers window list (see Figure 36).
6.2 Adding a Camera to AC-525 panel

Defining communication of AC-525 cameras to the ViTrax Server, is done physically between the camera and the AC-525 panel, see AC-525 Installation Manual.

The cameras available on this network are displayed when clicking the Network on the tree. When clicking the icon the camera list is displayed. Expand the tree to see which cameras are connected to which panels.

To configure a camera to the network:

- Configure the Network as seen in Sections 5.2-0.
  Once the camera is physically installed, the system reads the camera on the network and displays it on the tree.

To view the camera list:

- Click the Camera icon.
  The Camera list window is displayed.
6.3 Conditioned Recording via Panel Links

You can select the source, destination and period of recordings using Conditioned Recording sequences that are programmed using the Panel Links screen. For information of Panel Links window, see Setting Panel Links.

To create a panel link:

1. In the tree view, click on Networks. The available networks are listed in the display area.
2. Select a network and expand a panel in the tree view. Select Panel Links and select a link from the display area.

   Click on the Edit icon. The Links Window opens.
3. In Destination Type drop-down list, select **Local recording**.

4. In Destination drop-down list, select a camera: momentarily recording or pre event recording, and then click OK.

6.4 **Viewing Recorded events**

In the Camera Properties window you can view live streaming and edit various camera properties.

**To access Camera Properties:**

1. Double-click Camera <name> in the Tree View.

![Figure 41: Local Recording](image)

![Figure 42: Camera Properties](image)
2. Double-click Camera <name> in the Tree View. The Camera Properties window is displayed.

![Camera Properties window](image)

Figure 43: Camera Properties window

The Camera Properties window includes the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Camera hardware properties</td>
</tr>
<tr>
<td><strong>PC Archive</strong></td>
<td>Streams saved in PC</td>
</tr>
<tr>
<td><strong>Local Archive</strong></td>
<td>Streams saved in USB-key</td>
</tr>
<tr>
<td><strong>Audio from Camera</strong></td>
<td>Enable the option and select volume</td>
</tr>
<tr>
<td><strong>Audio to Camera</strong></td>
<td>Enable the option and select Microphone Device</td>
</tr>
</tbody>
</table>

3. Click OK.

**Note:**
ViTrax Server must be running to view recordings.

For more information on camera properties, see ViTrax Software Manual.
To access Live Video:

1. Right-click Camera <name> in the Tree View.

![Figure 44: View Live Camera](image)

2. In the Right-click menu, select View.
   The Live Video Streaming window is displayed.

![Figure 45: Live Video Streaming](image)

The Live Video Streaming window includes the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Recording" /></td>
<td>Recording</td>
<td>Saving streams to archive, page 20.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop</td>
<td>Stops Recording to the archive.</td>
</tr>
<tr>
<td><img src="image" alt="Audio to Camera" /></td>
<td>Audio to Camera</td>
<td>Speak from PC microphone by calling to Panel Ram</td>
</tr>
</tbody>
</table>

3. Click Cancel to close.
Manual Operation

7. Manual Operation

In addition to the AxTrax AS-525’s automated monitoring and control of the access control network, it is also possible to control the network directly.

7.1 Controlling the Door Manually

The Door Manual Operation window allows an operator to open or close a selected group of doors directly.

To manually open or close a door:

1. Click the **Open Door Manually** icon on the toolbar. The Door Manual Operation window opens.

![Door Manual Operation window](image)

**Figure 46: Door Manual Operation window**

The operator can sort the listed panels/doors in regular or reverse order by clicking the column header with the left mouse button.

2. Select an option:
   - **Open momentarily** - All selected doors are opened for the time set in the timer box.
   - **Open permanently** - All selected doors are opened.

---

Page 65 AS-525 AxTrax Software Installation and User Guide
• **Close output:** Close the selected doors and return control to the AxTrax AS-525.

3. Enable the checkboxes to select to which doors the operation applies.

   Click **Apply** to perform the operation.

**Note:**
Door Manual Operation can only control doors that have been set as Manual Door Open Enabled in the Door Properties window. See Setting Door Properties, page 35.

### 7.2 Changing the Reader Mode

The Manual Reader Operations window allows an operator to change the operation mode of a reader.

Readers have six possible operation modes:

- **Inactive:** The reader is not in use.
- **Card Only:** The reader will accept cards only.
- **PIN Only:** The reader will accept PIN inputs only.
- **Card or PIN:** The reader will accept both cards and PINs.
- **Desktop:** The reader is inactive, but can record new cards for the AxTrax AS-525 database.
- **No Access Mode:** The reader will not grant access to users.
- **Card + PIN:** The reader requires both a card and then a PIN. The PIN must be entered within 10 seconds of the card.

**To manually change the reader mode:**

1. Expand the Networks element on the tree view and expand a selected network.

   Select a panel in the tree view and click the **Change Reader Mode** icon.

2. Select an option:
   - **Change operation mode permanently** - Resets all selected readers to the selected operation mode.
   - **Change operation mode until Card + PIN starts** - Resets all selected readers to the selected operation mode until they enter a secured time zone. In the secured time zone, the operation mode switches to Card + PIN.
   - **Default** - Returns control of the readers to the system.

3. Enable the checkboxes to select to which readers the operation applies.

   Click **Apply** to perform the operation.

**Note:**
For more information on secured (Card + PIN) time zones, see General Reader Operation Settings, page 37.

### 7.3 Controlling Outputs Manually

The Manual Output Operation window allows an operator to open or close a selected group of outputs on a panel directly.

**To manually open or close an output:**

1. Expand the Networks element on the tree view and expand a selected network.

   Select a panel in the tree view, and then click the **Change Output Operation** icon.
Figure 48: Manual Output Operation window

2. Select an option:
   - **Open momentarily** - Opens all selected outputs for the time set in the timer box.
   - **Open permanently** - Opens all selected outputs.
   - **Close output and return to default mode** - Closes the selected outputs and returns control to the AxTrax AS-525.

3. Enable the checkboxes to select to which outputs the operation applies.

4. Click **Apply** to perform the operation.

7.4 Manually Disarming Inputs

The Manual Input Operation window allows an operator to disarm a selected group of inputs on a panel directly. An armed input means input is active; disarmed input is inactive and will not trigger any operation or alarms.

To manually disarm or re-arm an input:

1. Expand the Networks element on the tree view and expand a selected network. Select a panel in the tree view and click the **Change Input Operation** icon.
2. Select an option:
   - **Input permanently disarmed** - Deactivates all selected inputs.
   - **Arm input and return to default mode** - Reactivates the selected inputs and returns control to the AxTrax AS-525.

3. Enable the checkboxes to select to which inputs the operation applies. Click **Apply** to perform the operation.

### 7.5 Testing the Siren

The Manual Siren Operation window allows an operator to test the siren for a selected panel.

**To test the siren:**

1. Expand the Networks element on the tree view and expand a selected network.
   - Select a panel in the tree view, and then click the **Siren Operation** icons.
2. Select an option:
   - **Open momentarily**- Sounds the siren for the time set in the timer box.
   - **Close siren and return to default mode**- Silences the siren and returns control to the AxTrax AS-525.

3. Click **Apply** to perform the operation.
The AxTrax AS-525 supports two types of report. Immediate reports list details of recent movements (within the last few hours). They are shown in the display area and can be exported. Archive reports are immediately exported.

### 8.1 Immediate Reports

There are four types of immediate report:

- **Who’s been in today** - Lists where and at what time each user was granted access for the first time today.
- **Last known Position** - Lists where and at what time today each user was most recently granted access.
- **Roll-Call Readers** - Lists the last time each reader was accessed, and by whom, within the last 1–99 hours.
- **Roll-Call Areas** - Lists all users currently within the selected area, sorted by department and entry time. The report lists all personnel who entered the facility within the last 1–99 hours.

To show an immediate report, select it from the Reports element of the tree-view, under Immediate.

**To create a new immediate report:**

1. Expand the Reports element and select Immediate from the tree view.
2. Click the **New** icon on the toolbar. The Immediate Reports Wizard opens.
3. Select a report type and click **Next**
Follow the on-screen wizard instructions until the wizard has completed. The display area lists the new report.

### 8.2 Archive Reports

There are three ways of producing archive reports.

#### Panels events report

Panel event reports displays details of all recorded panel events.

There are 5 available panel event reports.

- **Attendance report** - Lists the attendance hours for selected users, sorted by date. Results include hours present, time in and time out.
- **Panels report** - Lists all the events recorded by the selected panels, sorted by date.
- **Access report** - Lists all access events recorded by the selected readers, sorted by reader and date.
- **Areas report** - Lists all users within selected access areas, sorted by department and date.
- **Readers report** - Lists all users who have accessed the selected readers, sorted by department and date.

#### System AxTrax events report

System AxTrax event reports list details of system and operator activity.

There are 3 available panel event reports.

- **System report** - Lists all operations performed by the AxTrax server, sorted by date.
- **Operators report** - Lists all the operations performed by registered system operators, sorted by operation event type and date.
- **Alarms report** - Lists all raised system alarms, sorted by operator and date.

#### Interactive report

Interactive reports list details of users and their access activity.

- **User details** - Lists selected users' details, including assigned cards, PIN and assigned access group.
- **Users access rights** - Lists site access details for selected users, with full details of readers accessed and in which time zones.
- **Not responding users** - Lists users for whom there have been no access events for a selected period of time.
9. Administrator Operations

9.1 Setting the Time and Date

Select panels by network and reset their date and time to the AxTrax server's system date and time, using the Set Time window.

**To reset the panel time:**

1. Expand the Networks element on the tree view and select a network.

2. Click the Set Time icon.
   
   The Set Time window opens.

   ![Set Time window](image)

   **Figure 52: Set Time window**

3. Select the panels to reset and click the **Apply** button.

   The server connects to the panels and sets the time as requested. A dialog confirms the operation.

9.2 Detecting Panels Automatically

It is possible to search for panels over the access control network. This is useful during installations; the AxTrax AS-525 finds all connected panels in the network and checks them. Panels can then be quickly activated and updated.
To detect panels:

1. Expand the Networks element on the tree view and select a network.

2. Click the **Find Panels** icon.
   
   The Find Panels window opens.

   ![Find Panels window](image)

   **Figure 53: Find Panels window**

3. Select the panels that should be activated.

   Click the **Apply** button to activate the panels and download setup information.

   Once the detection process is complete (may take 2-3 minutes), the display shows all of the detected panels and their corresponding information.

   Selected panels will then be automatically appended in the Tree View under current network.

### 9.3 Manual Download of Panel Data

Operators can manually download specific access-control panel configurations using the Download Data window. All of the panel’s data will be downloaded with no data parsing or filtering.

**To manually download panel data:**

1. Expand the Networks element on the tree view and expand a selected network.
2. Select a panel in the tree view and click the **Download Data** icon.

   The Download Data window opens.

![Download Data window](image)

Figure 54: Download Data window

3. Click the **Apply** button to apply the operations.

### 9.4 Downloading Failed Data

In the event that some data failed to download into the access control panels, it is possible to perform a download of the failed operations only. This operation can be done on a single panel, on all the panels in a network or on all the panels in the entire system.

**To download failed data:**

1. In the Tree View, select a specific panel, a specific Network or the entire Networks.

2. Select and click the **Download Failed Data** icon.

   The Download Data icon window opens.
3. Select the required parameters to download by checking the checkbox next to each parameter, you can use to the **Select All** and **Select none** for fast selection.

Click the **Enable Selected** or **Disable Selected** button to apply the status to the selected parameters.

### 9.5 Testing User Counters

When using User Counters, it is possible to view current User count value in each panel that has Reader designated with "Deduct User" option.

**To view User Counters:**

1. In the Tree View, select **Department\Users** then select one User in Display area.

2. Select and click the User Counter icon ![User Counter Icon](image), the Request User Count window opens.
3. Click the **Test** button to read a User Counter in each of the panels.

### 9.6 Maintaining the Database

The system database is maintained from the Database window.

**Note:** This option is only available within the AxTrax Server system.

To open the Database window, select **Tools > Database** from the menu bar.

The following database operations are available:
## Administrator Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Periodic Backup</strong></td>
<td>Run a scheduled backup every specified number of days at the specified time.</td>
</tr>
<tr>
<td><strong>Backup now</strong></td>
<td>Run a one-time backup immediately.</td>
</tr>
<tr>
<td><strong>Export Configurations and Events</strong></td>
<td>Copy the contents of the database to the selected folder.</td>
</tr>
<tr>
<td><strong>Import Configurations</strong></td>
<td>Replace the current configuration based on the imported file.</td>
</tr>
<tr>
<td><strong>Import Configurations and Events</strong></td>
<td>Replace the current configuration and events based on the imported file.</td>
</tr>
<tr>
<td><strong>Erase Configuration and Events</strong></td>
<td>Erase the current database configuration and all events.</td>
</tr>
<tr>
<td><strong>Import earlier database versions from AS-215</strong></td>
<td>Replace the current database. Only VeriTraq AS-215 databases from versions 0.5-2.02.04 and 2.05.00-2.05.05 or newer can be migrated.</td>
</tr>
<tr>
<td><strong>Import earlier database versions from VeriTraq AS-225 / AxTrax AS-525</strong></td>
<td>Replace the current database. VeriTraq AS-225 or AxTrax AS-525 databases from versions 0.00.04 or newer can be migrated. Note that this option does not allow importing a database from a current AxTrax AS-525 version.</td>
</tr>
<tr>
<td><strong>Limit panel Events period</strong></td>
<td>Automatically erase events when they are older than a specified number of days. Before using this option, Rosslare recommends that you set a periodic backup.</td>
</tr>
<tr>
<td><strong>Erase panel Events</strong></td>
<td>Erase all events that are older than a specified number of days.</td>
</tr>
</tbody>
</table>

### Note:

The Backup and Export functions add the "_VeriTraq vX" prefix at the end of exported or backed-up database. The Import database function will execute only with the string at the end of the file name. After a database has been imported, the panel status may change to disabled. If this is the case, the operator should re-enable the panels.
9.7 AxTrax Options and Preferences

The AxTrax AS-525 can be customized to meet the preferences of the operator using the Options window. To open the Options window, select Tools > Options from the menu bar. The Options window has four tabs:

- General startup, presentation and connection preferences
- Settings to control AxTrax information pop-ups
- Additional user-defined fields for the User Properties window
- Report title settings

Startup, Presentation and Connection Options

The General tab includes basic control over AxTrax AS-525 start-up and security options, user highlighting preferences and transaction connection settings.

![General tab](image)

**Figure 58: General tab**

The General tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto startup</td>
<td>Enable the checkbox to start the AxTrax AS-525 automatically when the computer is turned on.</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Language</strong></td>
<td>Select the system interface language. This option will temporarily switch language until you close AxTrax AS-525. Permanent language settings are set under Operators options.</td>
</tr>
<tr>
<td><strong>HASP Key</strong></td>
<td>Enable this checkbox if the system consists of less than 64 panels and you require the operation of the installed VeriTime attendance software. This is possible by checking if VeriTime option is selected in the HASP key.</td>
</tr>
<tr>
<td><strong>Outlook</strong></td>
<td>Enable the checkbox to load Microsoft Outlook™ holidays into the AxTrax AS-525.</td>
</tr>
<tr>
<td><strong>Select Holiday</strong></td>
<td>Click the button to select Microsoft Outlook™ holidays to load into the AxTrax AS-525. This button is only available when the Outlook checkbox has been enabled.</td>
</tr>
<tr>
<td><strong>Show download succeed</strong></td>
<td>Enable the checkbox to add a message to event history upon successful system parameters download from the AxTrax AS-525 software to the panel.</td>
</tr>
<tr>
<td><strong>Use highlight user events</strong></td>
<td>Enable the checkbox to display selected user information in a colored highlight.</td>
</tr>
<tr>
<td><strong>Selected user / All users</strong></td>
<td>Enable one of the checkboxes to highlight either selected users or all users. When Selected Users is enabled, users are highlighted when they have been marked for highlighting in the User Properties window. See General User Properties, page 45.</td>
</tr>
<tr>
<td><strong>Unknown key</strong></td>
<td>Enable this checkbox to highlight every record of attempted access by an unknown card or PIN.</td>
</tr>
<tr>
<td><strong>Use highlight alarm events</strong></td>
<td>Enable the checkbox to highlight selected alarm events.</td>
</tr>
<tr>
<td><strong>Selected alarms / All alarms</strong></td>
<td>Enable one of the checkboxes to highlight either selected or all alarms. Alarms are selected if they have been marked for highlighting in Panel Links window. If All Alarms is enabled, all alarms are highlighted. See Setting Panel Links, page 52.</td>
</tr>
</tbody>
</table>
Field Description

**Use highlight Network and Panels**

This option can be used to quickly identify panels that are not responding or networks, which include panels that are not responding.

When selecting the root "Networks" tree view, Networks with panels that are not responding are highlighted with the selected color on display area.

When selecting a specific Network on tree view, panels that are not responding will be highlighted with the selected color on display area.

Panels that are currently disabled are not considered as "not responding".

**Select color**

Click to select a color for highlighting.

---

**Pop-up Options**

The Pop-up tab controls the behavior of pop-up Event alarms in the system.

![Pop-up tab](image)

**Figure 59: Pop-Up tab**

The Pop-up tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable pop-up alarm window</strong></td>
<td>Enable this checkbox to activate pop-up alarm notifications.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
Access Granted | Enable this checkbox to display a pop-up notification whenever a reader grants a user access. This option is only available from the AxTrax server.

Access Denied | Enable this checkbox to display a pop-up notification whenever a reader denies a user access. This option is only available from the AxTrax server.

Access Recorded | Enable this checkbox to display a pop-up notification whenever an “access recorded” event occurs. This option is only available from the AxTrax server.

Closed by Manual / Timer | Select to close display pop-ups either manually, or after a set duration.

Display Window | Determines which of the User’s windows to pop-up.

**User Defined Fields**

The User Fields tab controls which fields are shown on the User Fields tab of the User Properties window. See User Defined Data, page 50.

![Figure 60: User Fields tab](image)

The User Fields tab contains the following fields:

Field | Description
---|---
Field description | Enter a name for the new field.
Field type | Select the type of field.
Add | Click to add this field.
Field Description

Remove Click to delete the selected field.

Report Title Settings

The Report title tab controls basic presentation preferences for the reports generated by the AxTrax AS-525.

![Figure 61: Report Title tab](image)

The Report title tab contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>Enter the company name to be shown on reports.</td>
</tr>
<tr>
<td>Font</td>
<td>Click to set a font and color for the company name.</td>
</tr>
<tr>
<td>Company details</td>
<td>Enter the company address.</td>
</tr>
<tr>
<td>Show report title</td>
<td>Enable the checkbox to display this company name and logo on the reports.</td>
</tr>
<tr>
<td>Logo Add / Clear</td>
<td>Click to select a logo to be printed on reports. If a logo has already been selected, click to remove it.</td>
</tr>
</tbody>
</table>

9.8 Importing User Data

The Import Data window makes it possible to import user information into the AxTrax database from a standard spreadsheet file.
Figure 62: Import Data

The Import Data window contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Type</strong></td>
<td>Select the type of data to import.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>The location of the file to import.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Click to select the file to import.</td>
</tr>
<tr>
<td><strong>Excel file Row</strong></td>
<td>Enter the first row of user data in the spreadsheet.</td>
</tr>
<tr>
<td><strong>User number started from</strong></td>
<td>Enter the number from which to start assigning unique system user numbers.</td>
</tr>
<tr>
<td><strong>Import Departments?</strong></td>
<td>Select <strong>Yes</strong> to import new departments into the AxTrax database.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>No</strong> to import users without their departments.</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>Select the department to assign to the imported users.</td>
</tr>
<tr>
<td></td>
<td>This box is only active when the Yes button is selected.</td>
</tr>
<tr>
<td><strong>Excel File Columns</strong></td>
<td>Enable the columns to be imported.</td>
</tr>
<tr>
<td></td>
<td>Data in each column (A—M) will be imported as listed.</td>
</tr>
</tbody>
</table>
Appendix A. Firewall Configuration

The following instructions explain how to configure the standard Windows Firewall for Windows XP.

To configure the firewall:

1. Click the My Computer icon on the desktop.
   The My Computer folder opens.
2. Select the Address Bar and type "Control Panel". Hit the Enter key.
   The Windows Control Panel opens.

![Figure 63: Windows Control Panel]

3. Click the **Security Center** category.
   (If the Control Panel is in "Classic View", click Switch to Category View in the top-left Control Panel preferences pane and click the **Security Center** category.)

   The Windows Security Center opens.
4. Click **Windows Firewall**.

The Windows Firewall opens.

Select the Exceptions tab.

5. Click **Add Program**.

Figure 64: Windows Security Center

Figure 65: Windows Firewall
The Add a Program dialog appears.

![Add a Program dialog]

**Figure 66: Add a Program to the Firewall List**

6. Click **Browse**.
   
The Browse dialog appears.

7. In the File Name box, type:
   
   "C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\BIN\sqlservr.exe"
   
   Hit Enter.
   
The sqlservr program appears in the Add a Program dialog.

8. Select the program and click **OK**.
   
The sqlservr program appears on the Windows Firewall list of exceptions.

9. Repeat steps 5 and 6. In the File Name box, type:
   
   "C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe"
   
   Hit Enter.
   
The sqlbrowser program appears in the Add a Program dialog.

10. Select the program and click **OK**.
    
The sqlbrowser program appears on the Windows Firewall list of exceptions.
    
    Click **OK**.

11. Repeat steps 1 and 2.
    
The Control Panel window opens.

12. Click the **Performance and Maintenance** category.
(If the Control Panel is in "Classic View", click Switch to Category View in the top-left Control Panel preferences pane and click the **Performance and Maintenance** category.)

The Performance and Maintenance window opens.

![Performance and Maintenance window](image)

**Figure 67: Performance and Maintenance window**

13. Click **Administrative Tools**.

The Administrative Tools window opens.

![Administrative Tools window](image)

**Figure 68: Administrative Tools window**

15. Right click on Windows Firewall/Internet Connection Sharing (ICS). Click Restart from the pop-up menu.

16. Right click on SQL Server. Click Restart from the pop-up menu.

17. Right click on SQL Server Browser. Click Restart from the pop-up menu. The Firewall is now configured for AxTrax AS-525.
Appendix B. Network Configuration

The AxTrax Server connects to access control units by a serial connection, a TCP/IP connection or a Modem-to-Modem connection.

To connect access control panels to the AxTrax AS-525 over a TCP/IP LAN (Local Area Network) or WAN (Wide Area Network), the use of a TCP/IP to Serial converters required unless the panel has onboard TCP-IP connection (AC-225IP or AC-525).

Each TCP-IP connection can support up to 32 access control panels connected using RS-485 with each other.

The hardware used to connect to TCP-IP network may be the MD-N32 which is a Serial to Ethernet converter, or using the onboard converter of AC-225IP or AC-525.

You can also use Rosslare’s MD-N33 modem for Modem to modem connection. Refer to the hardware installation manuals of the desired panel for more details.

TCP/IP and Modem-to-Modem connections must be configured for use, and require expert knowledge of the local network.

**To configure TCP-IP Connection for AxTrax AS-525:**

1. In the tree view, click on Networks. Click the **Edit** icon on the toolbar. The Networks window opens.
2. Set the Network type as TCP/IP.
3. Click the **Configuration** button. The TCP/IP Configuration window opens.

**Note:**

If you want to work with Remote in TCP/IP Network window select Remote (WAN), and add the WAN IP Address of the PC.
Figure 70: TCP/IP Configuration window

The upper left window lists all TCP/IP converters attached on the local network, identified by their MAC address, and if they are available to assign to a new panel network or are already assigned.

4. Select the appropriate MAC address from the MD-N32 list (The MD-N32's MAC address should be labeled on the TCP/IP converter).

In "Gateway Type" select the type of TCP/IP converter, MD-N32, MD-IP32 On board, or any other valid option. Skip this selection if it is already valid.

In the appropriate fields, enter the Local IP address and Subnet for the computer's network.

Enter the Port number and select the speed of your connection. It is recommended to select a higher value port number (4001 or higher). Note that the selected should not end with zeros (prefer setting Port value of 4243 rather than 4200). This will avoid colliding with port addresses reserved for various equipment installed on the same network.

5. Click OK to start the verification process.

6. Click OK twice and verify that the AxTrax AS-525 software accepted the configuration.

7. Turn off the MD-N32 power (or panel power if using the onboard module, such as MD-IP32) and then turn power on again. This step is necessary when using certain versions of MD-N32 or MD-IP32 models. Skip this step if not applicable.
8. If configuration applies to WAN network, disconnect the configured unit from the local network and re-connect to the WAN network and access control panels network working over the WAN.

To configure MD-N33 in AxTrax:
1. Add a new network in AxTrax software.
2. Under network type select Modem.

![Network Configuration](image)

**Figure 71: AxTrax AS-525 Modem Network**

**Note:**
Communication speed is limited to 9600, 19200, 57600, or 115200 bits per second.

**To Initialize and Configuring the Computer Modem**
1. In the Network window, click the Configuration button. The Modem Configuration window opens.
2. In the **Dialing** area, under **Remote modem phone number**, enter the destination telephone number to call.

3. Click to change the **Number of dial attempts** (if required).

   For most applications, the default dialing string is sufficient.

   The dialing string is displayed in the window.

4. Clear the **Use default** checkbox. This allows adding or editing of the dialing string. Then type the AT command in the **Dialing string** window.

5. Select the time zone from the **Dialing schedule** drop down list.

6. Choose the disconnecting condition: "Disconnect by schedule end" or "Disconnect on upload complete".

   (This option is enabled when the selected time zone is different from the default time zone (Always & Never).

7. In the **Settings** area the initialization string is displayed in the window.

   For most applications, the default initialization string is sufficient.

8. Clear the **Use default** checkbox to allow adding or editing of the dialing string. Then type the AT command in the **Dialing string** window.

9. Connect the computer's modem to the PC via the selected COM port and click "Apply" to initialize the PC modem.

10. Click **OK** to complete the initialization.
11. If the computer displays a failure message, check the modem connections and repeat the last steps.

**Note:**
Remote modem initialization is at the PC side. When modem initialization fails through telephone line, a message appears.

**Initializing and Configuring the Remote Modem**

To initializing and configure the remote modem.

1. In the Modem Configuration window, click the **Remote modem** tab.

2. In the **Settings** area the initialization string is displayed in the window. For most applications, the default initialization string of AS-525 is sufficient.

3. Clear the **Use default** checkbox to allow adding or editing of the dialing string. Then type the AT command in the **Dialing string** window.

4. Set the number of rings before the computer modem answers.

5. Connect the remote modem to the computer via the selected com port and click **Apply** to initialize the computer modem.

6. Click **OK** to initialize.
Network Configuration

7. If a failure message appears, check the modem connections and repeat the last steps.

Note:
You must perform the action twice at the PC side, to Initialize two MD-N33’s.

The MD-N33 and AxTrax AS-525 software are now configured and ready. (You can now continue working using the AxTrax Adding New Panel procedure).

To check the remote modem status:

1. When panel is setting in a modem network, you can see the status of the modem by clicking the phone icon in the toolbar.
2. There is a manual option to dial or disconnect the modem.

![Modem status](image)

Figure 74: AxTrax AS-525 Modem Status

3. In order to prevent access to AxTrax data from non-authorities users, the AC-215, AC-225 or AC-525 access control panels contain a password that can be changed only when the modem is connected and there is a link with the panel.

Note:
The default password for the modem configuration and status screens is VeriTrax.

You may be asked to enter the password during first data configuration, such as adding a new panel or downloading a new firmware.
Restoring Factory Default Settings

If the modem configuration password is lost or forgotten, reset the access control panel to the factory default settings and use the default "VeriTrax" password.

**Caution:**
Restoring factory default settings resets all doors and reader configurations to their factory defaults and clears all user properties.

**To restore the factory default settings:**

1. Turn off the supply power.
2. Disconnect all doors and readers wiring.
3. Connect Data 0, Data 1 and Tamper inputs to GND (-) in both reader 1 and 2 (total of 6 wires)
4. Power up the supply power for few seconds. Wait for the "LED3" and "LED4" LEDs to flash alternately.
5. Turn off the supply power.
6. Connect the doors and readers wiring again.
7. In AxTrax AS-525, delete the panel by clearing the **Enable panel** checkbox in the panel screen. Click **OK**
8. Check the **Enable panel** checkbox in the panel screen and click **OK**. This action causes a full reset of the access control panel with the factory settings.
9. Dial to the appropriate access control panel and click on **password** in the modem status screen. Use **AxTrax** as the current password and change the password to a new one.
Appendix C. Technical Support

Asia Pacific, Middle East, Africa
Rosslare Security Products Headquarters
905-912 Wing Fat Industrial Bldg,
12 Wang Tai Road,
Kowloon Bay Hong Kong
Tel: +852 2795-5630
Fax: +852 2795-1508
E-mail: support.apac@rosslaresecurity.com

United States and Canada
1600 Hart Court, Suite 103
Southlake, TX, USA 76092
Toll Free: +1-866-632-1101
Local: +1-817-305-0006
Fax: +1-817-305-0069
E-mail: support.na@rosslaresecurity.com

Europe
Global Technical Support & Training Center
HaMelecha 22
Rosh HaAyin, Israel 48091
Tel: +972 3 938-6838
Fax: +972 3 938-6830
E-mail: support.eu@rosslaresecurity.com

South America
Pringles 868, 1640 Martinez
Buenos Aires
Argentina
Tel: +54 11 4798-0095
Fax: +54 11 4798-2228
E-mail: support.la@rosslaresecurity.com

Web Site: www.rosslaresecurity.com